

    
      
          
            
  
Kdenlive 26.04 Manual

Welcome to the manual for Kdenlive, the free and open source video editor.

The current Kdenlive version you get here. Check out what’s new.

You can download this manual as an EPUB.
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Začínáme

Welcome to Kdenlive! This chapter will get you started with Kdenlive in no time.

Introduction - This chapter talks about what Kdenlive is and is not, and some of the features you can expect

Installation - This chapter will cover everything from minimum system requirements to installing Kdenlive on Linux, Windows and MacOS

Quick Start - This chapter shows you step by step how to create a new project, add clips, work with the timeline, add effects and music, and finally how to render your project into a video

Tutorials - This chapter contains links to written tutorials and video tutorials on YouTube

Configuration - This chapter describes the various configuration settings available in Kdenlive to adapt it to your preferences and editing workflow







            

          

      

      

    

  

    
      
          
            
  
Uživatelské rozhraní

This section introduces the Kdenlive user interface (UI), explains the various elements, icons and buttons, the menu options, the default keyboard shortcuts that can speed up your editing work, and how you can customize the layout to fit your specific post-production workflow.

After starting Kdenlive the window should look similar to the image below. Kdenlive’s user interface (UI) is consistent across all platforms, so it doesn’t matter whether your operating system is Linux, Windows or MacOS. Of course, icons and text look different.

The UI is separated into four main parts:

[A] The Workspace with the various widgets that can be arranged to your needs. See the Nabídka Pohled and Rozvržení pracovní plochy for more details.

[B] The Menu Bar with the Menu and list of Rozvržení pracovní plochy.

[C] The Panely nástrojů below the menu bar and above the Časová osa.

[D] The Stavový řádek at the bottom of the screen.


[image: _images/kdenlive2304_ui-screen_layout.webp]

Kdenlive’s default screen layout (example uses the Editing view): Menu Bar (blue), Toolbars (yellow), Workspace (green) and Status Bar (red).



Pracovní plochy

The Workspace model follows the video editing workflow and can be adapted to your individual style and preferences. By default, Kdenlive starts with the Editing workspace model that looks like this:


[image: _images/kdenlive2304_ui-workspaces.webp]

Kdenlive’s default workspaces (example uses the Editing view)




	[1] Project Bin, Library:

	This is where you keep your source files (video clips, images and image sequences, title and color clips, animations, audio files). In this screenshot the widgets for Undo History, Compositions, and Effects have been added to this section.



	[2] Monitor klipu:

	This is where the clip selected in the project bin is displayed. In this screenshot the widget for Library has been added to this section. See the chapter Monitor klipu for more details.



	[3] Monitor projektu:

	This is where the content of the timeline is being displayed with all effects and compositions applied. In this screenshot the widgets for Speech Editor and Project Notes have been added to this section. See the chapter Monitor projektu for more details.



	[4] Časová osa:

	Most of the action is taking place in the timeline. Here you put your sources in the order in which they will appear in the final video, make your edits (cuts and trimmings), apply effects, add compositions and transitions, and add audio and sound tracks. See the chapter Časová osa for more details.



	[5] Panel nástrojů časové osy:

	This is where you find all the tools you need to edit your video project. See the chapter Panel nástrojů časové osy for more details.



	[6] Zvukový směšovač:

	This section holds the audio mixing panel where you control the volume and pan of the various audio tracks and the master.



	[7] Menu Bar, Toolbar:

	At the top of the screen you have access to the menu (see Hlavní nabídka and Menu for more details), the Rozvržení pracovní plochy and the Hlavní panel nástrojů. The menu bar can be switched on and off with Ctrl+M.



	[8] Stavový řádek:

	Kdenlive displays context-specific information or hints on the left-hand side of the status bar depending on where you hover the mouse pointer. In the middle you see the names of the clips you hover over in the timeline. This is also where error messages come up when working with clips in the timeline. On the right-hand side Kdenlive displays the currently selected timeline edit tool and the icons to toggle various timeline features. See the sections about status bar icons and the status bar for more details.











            

          

      

      

    

  

    
      
          
            
  
Project and Asset Management




Kdenlive works with projects. A project contains all the assets (sources), the timeline with your clips in different tracks, the cuts and trims, compositions and transitions, annotations, markers, timeline marker - in short, everything you and Kdenlive need to produce a video file as the result of your work.


Rada

When creating a project, select a project profile with the final video in mind. The project settings determine the resolution (e.g. 1920x1080), the frame rate (e.g. 25 fps), other metadata, and how to deal with the project’s assets.




Poznámka

You can change the project profile later but it is not recommended as it may lead to undesirable results, in particular when you use keyframes.



The Project Bin holds all your assets. You can load (or import) video and audio files, single images or entire image sequences, create color and title clips, animations, and download assets from various online sources directly into your project.

While the project bin is for a specific project, you can use the library feature to store assets for use in other projects. That is also the only way to share or copy assets between projects.

Kdenlive offers limited video and audio capturing functionality, for example to create voice overs, or use screenshots.

You can take notes for your project that capture timestamps for easy reference during the editing process. This is very useful for big and complex projects or productions.

Kdenlive has an auto-save feature, creates backups in the background, and allows to archive a project with all the assets included.




            

          

      

      

    

  

    
      
          
            
  
Cutting and assembling







            

          

      

      

    

  

    
      
          
            
  
Efekty a filtry

Effects and Filters are very important components in video editing. In Kdenlive, effects and filters are provided by frei0r or avfilter (Kdenlive does not have built-in effects or filters of its own).

Effects are used to change the appearance of or manipulate a clip. For example, the Transform effect allows to scale and move the clip; the Brightness effect changes the brightness of the clip; effects in the Alpha, Mask and Keying category provide very specific filters for masking or rotoscoping.

Kdenlive has two groups of effects: Video Effects and Audio Effects.

Je několik způsobů použití efektů:


	On the clip in the Project Bin, which makes the effect available in all instances of that clip in the Timeline


	On the clip in the Timeline, which makes the effect only applicable for that clip in the Timeline at that point


	On the track, which applies the effect to all clips in that particular track


	On Master, which applies that effect to all clips in all tracks





Poznámka

Not all effects can be used at the track or Master level nor does it make sense.




Built-in Effects

The built-in effects are disabled by default. So you have to enable it before you can use it.

All built-in effects can be disabled/enabled globally in Settings ‣ Configure Kdenlive -> Misc


[image: _images/kdenlive2412_builtin-effect_disable.webp]

Under Misc you can disable/enable all built-in effects. Default is disabled.



When dragging a clip into the timeline, the Flip and Transform effects are always added to the video part of the clip; for the audio part the Volume effect is added by default.

These are the most used effects which you now have at your fingertips without the need to add them manually.

[image: video-effect] < video part | audio part > [image: audio-effect]

Built-in effects can be used in four places:


	on a clip in the project bin (Transform and Flip, audio part: Volume)


	on the timeline when a clip is clicked (video part: Transform and Flip, audio part: Volume)


	on the track header (only Flip on video track and Volume on audio track)


	as master effect (only Flip and Volume)






Karta efektů

Make the Effects widget visible in Menu ‣ View ‣ Effects.

The Effects widget has eight control icons that show or hide the different effect categories:


[image: _images/kdenlive2412_effects_tab.webp]

Kdenlive Effects widget as a tab in the Project Bin area



[image: show-all-effects]Main effects shows all video and audio effects (default view)

[image: kdenlive-show-video]Show all video effects shows all video effect categories only

[image: kdenlive-audio]Show all audio effects shows all audio effects categories only

[image: kdenlive-custom-effect]Show all custom effects shows all effects you have created by saving an effect stack.

[image: favorite]Show all favorite items shows all effects that were flagged as a favorite effect. This is the same list that appears when selecting Insert an effect from the right-click menu of a clip in the Timeline, or by clicking the Favorite Effects in the Timeline toolbar.

[image: edit-download]Download New Effects opens a dialog window where effect templates are listed from the KDE Store

[image: view-filter]Only show reviewed assets toggles between the effects which are reviewed and tested by the Kdenlive team and not tested effects (still in test phase).
Show 10 bit compatible only it hides assets not compatible with a 10-bit pipeline. Use the 10 Bit category or the NVENC H265 ABR 10 bit codec for rendering.

[image: help-about]Show/hide description of effects toggles the information display below the effect list where a short description of what the effect does is displayed when on. Click on the blue effect text opens the online documentation to this effect.



Effect/Composition Stack

This widget is also known as the Properties Tab as it lists all effects applied to the currently selected clip as well as each effect’s settings or properties. If a Composition is selected the widget displays the composition’s settings or properties.

[image: efekt] < effect | composition > [image: composition]


Poznámka

Only Effects can be stacked, Compositions cannot.




Effect/Composition Stack Functions


[image: _images/kdenlive2304_effects-effect_stack.webp]

Kdenlive Effect Stack



[image: document-save-all] Save Effect - Opens a dialog window for entering a name for the effect stack under which it will be listed in the Custom effect category and a comment which will be displayed in the information display

[image: view-split-left-right] Compare Effect - Splits the Preview Monitor vertically to do a side-by-side comparison of the clip with and without effects

[image: visibility] Effects enabled - Switches the effect stack on or off. This is equivalent to disabling all effects in the effect stack.

[image: keyframe-disable] Hide/Show keyframes in Timeline - Switches the display of keyframes in the clip in the Timeline on or off

When an effect is applied to a clip in the timeline you can click on the effect button to enable/disable the clip stack of this clip. When disabled the effect name on the clip is strikeout.


[image: _images/kdenlive2402_effects-effect_stack_disabled.webp]

Kdenlive Effect Stack disabled by click on the effect of a clip





Funkce efektu


[image: _images/kdenlive2412_effects-effect_panel.webp]

Kdenlive Effect Panel




	1:

	[image: go-down] Expand/collapse the effect panel. Shift + click to expand/collapse all effects

[image: keyframe-disable] Hide/show keyframes - Turns the display of the keyframe ruler off or on

[image: zoom-fit-width] Use effect zone - Toggles the display to show the effect zone

[image: visibility] Disable effect - Turns the effect off or on. The effect stays in the stack but is not applied during playback or rendering.

[image: adjustlevels2] Presets - Opens a list of advanced options to manage presets for the effect (e.g. reset the effect to its default parameters).

[image: document-save] Save effect - Opens a dialog window for entering a name for the effect under which it will be listed in the Custom effect category and a comment which will be displayed in the information display

[image: help-about] Open effect documentation in browser  - This opens the online documentation to this effect

[image: selection-raise] Move effect up - Moves the effect up one notch in the list (effect sequence from top to bottom is important)

[image: selection-lower] Move effect down - Moves the effect down one notch in the list (effect sequence from top to bottom is important)

[image: edit-delete] Delete effect - Removes the effect from the effect stack

arrow up/down goes to the next effect in the list



	2:

	Effect function with check box only



	3:

	Effect function with selector



	4:

	Effect with keyframes



	5:

	
	Effect values and action button ([image: object-rotate-right]).


	The tooltip Support basic math expression shows if the following basic math functions are possible:
+ - * / ( ). It doesn’t follow standard order of operations:
multiplication (×) and division (÷) must be performed before addition (+) and subtraction (-).
For standard order of operations you have to use parentheses ( ).


	The tooltip use „%…“ to reference other spinbox’s value shows which other parameter you can use in the formula:
positions, size, scale, opacity, number of value field
(use %x %y %w %h %s %o %1-n).
If an effect has several fields with the same type of value, it shows a number like %3.
You can add a basic math to that link like: %y*2


	If an effect has a timecode field, you can add or subtract time by starting with + or -.
The format is [+/-]hh:mm:ss:ff. You can add time in short form:



	1:: adds/subtracts 1 hour 1:00:00:00


	2: adds/subtracts 2 minutes 00:02:00:00


	12. adds/subtracts 12 seconds 00:00:12:00


	9 adds/subtracts 9 frames 00:00:00:09


	2:.9  adds/subtracts 2 minutes and 9 frames 00:02:00:09









	Reset value to default by clicking with the MMB [3] on the slider or value.











Applying an Effect


Where to apply an effect

An effect can be applied at four different levels of your project:


	On a clip in the timeline: it will affect only this clip


	On an clip in the bin: it will affect all the occurrences of this clip in the timeline


	On a track: it will affect all the clips on this track


	On the Master: it will affect your global output






How to apply an effect

For applying an effect to a clip in the Project Bin or in the Timeline, you can choose one from the Effects Tab and drag it onto the clip.

You can also double-click on an effect in the Effects Tab which adds the effect to the clip in the Project Bin which appears in the clip monitor. In the Timeline, it adds the effect to the clips which are selected. So you can apply an effect to several clips at once in the timeline.

Another method is to use the [image: favorite]Favorite Effect icon in the Timeline toolbar and select the effect from there (you add an effect to the favorite effects by right-click on the effect in the Effects Tab and select Add to favorites).

Alternatively, you can use Menu ‣ Sequence ‣ Add Effect to select an effect from the various categories and add it to the selected clip(s) in the Timeline.

And last but not least you can copy effects with all their settings from any clip (Timeline or Project Bin) and paste them to other clips.

For applying an effect to a track, see Track Effect.

For applying an effect to the Master, see Master Effect.


Poznámka

Effects are always added at the bottom of the effect stack, and since the effect order is important, can be re-arranged.






Keyframes in Effects

Many effects use the concept of „Keyframes“. Keyframes are user-defined points in your clip where you want an effect to start, stop or change. You can set the parameters for your effects to different values at different keyframes and Kdenlive will then gradually change the parameters between the two keyframes so that by the time the video has arrived at the next keyframe it will have adjusted the parameter to match that keyframe. It interpolates between keyframes.


Keyframes types, interpolation

Select the keyframe interpolation icon for selecting the keyframe type. See Rychlý start for an example on keyframing the RGB adjustment effect.


[image: _images/kdenlive2402_effects-keyframe_types.webp]

Kdenlive keyframe types



The first three keyframes are: Linear, Discrete and Smooth (Centripetal Catmull-Rom spline interpolation). This are standard keyframes. More details about keyframes are here.

The next ten keyframes are easing keyframes which calculations are based on Robert Penners equations[2].

Objects in real life don’t just start and stop instantly, and almost never move at a constant speed. When we open a drawer, we first move it quickly, and slow it down as it comes out. Drop something on the floor, and it will first accelerate downwards, and then bounce back up after hitting the floor.

Easing keyframes: The left end is the start of the movement, and the segments in blue and green represent faster movement.


[image: _images/kdenlive2402_effects-ease-bounce.webp]


[image: _images/kdenlive2402_effects-ease-cubic.webp]


[image: _images/kdenlive2402_effects-ease-exponential.webp]


[image: _images/kdenlive2402_effects-ease-circular.webp]


[image: _images/kdenlive2402_effects-ease-elastic.webp]

Smooth (deprecated): Is the smooth Catmull-Rom spline interpolation keyframe before Kdenlive 24.02.



Keyframe ruler

The keyframe ruler has zoom bars which makes adjusting keyframes a lot easier if the clip’s duration is relatively long and the effect stack widget is too narrow to display all keyframes nicely spaced.


[image: _images/Zoombar-effects.gif]


[image: _images/keyframe_toolbar_copy-paste.png]

Keyframes can be copied and pasted between effects and even across clips using the standard shortcuts Ctrl+C, Ctrl+V



Keyframe Curve Editor

Implemented with version 24.08 the keyframe curve editor is still in alpha state. Improvements will come with upcoming versions.

The curve editor is showing the keyframe type and their curves.


[image: _images/curve-editor_enabling.webp]

To switch to the curve editor click on [image: switch-to-curve-editor-view]Switch to curve editor view.

The curve editor can only be enabled on effects which have the following parameters: X, Y, width, height, opacity (alpha, optional) and rotation. For all other effects the curve editor is greyed out.

By double clicking into the window new keyframes get added. Hovering over a keyframe, the cursor changes to a cross and you can:


	move the keyframe to change the value, depending on which tab you are (X position, Y position, Width, Height, Opacity, Rotation). Hold Ctrl moves the keyframe vertically only.


	click on the keyframe and change the keyframe type





[image: _images/curve-editor_example-view.webp]

In this example, the cursor enables the second keyframe and you can either change the values by moving the keyframe or change the values directly in the boxes below the curve editor view.


[image: _images/curve-editor_switch-back.webp]

To switch back to the timeline view click on [image: switch-to-timeline-view]Switch to timeline view.



Working with Keyframes in the Effect Stack

The effect keyframe panel allows comprehensive manipulation of keyframes:


[image: _images/Move-kf-to-cursor.gif]


	Select the keyframe you want to move


	Move the cursor to the position where you want to move the keyframe to


	Click on [image: align-horizontal-center]Move selected keyframe to cursor






[image: _images/Duplicate-keyframe.gif]


	Select the keyframe you want to duplicate


	Click on [image: edit-copy]Copy keyframe


	Move the cursor to the position where you want to insert the new keyframe


	Click on [image: edit-paste]Paste keyframe








[image: _images/Apply-value-to-selected-kf.gif]


	Select all keyframes you want to apply the value on


	Go to one of the selected keyframes and change the value(s) as you want


	Click on [image: nabídka aplikací]Options and select Apply current position value to selected keyframes


	Select the parameters you want to apply and click on OK








[image: _images/Kf-ctrl-select.gif]

Select multiple individual keyframes with Ctrl+LMB





[image: _images/Kf-rubber-select.gif]

Select contiguous keyframes with Shift+LMB





[image: _images/Multiple-kf-move.gif]

Moving multiple keyframes at once





Typy klíčových snímků

Easing functions are based on Robert Penner's Easing Functions.



Exchanging Keyframes Across Effects

You can import and export keyframes from/to the clipboard. This feature is not only useful to copy keyframes from one clip to another, it can also be used for example to copy the results of the motion tracker to the Transform effect.

To export the keyframes to the clipboard click on [image: nabídka aplikací]Options in the keyframe panel[1] and choose Copy keyframes to clipboard.


[image: _images/Kdenlive_import_keyframes_dialog.png]

Importing keyframes



To import keyframes from the clipboard click on [image: nabídka aplikací]Options inside the keyframe panel[1] and choose Import keyframes from clipboard. If you have valid data on your clipboard you should see this dialog window where you can adjust the mapping of the data.

For most use cases the default settings suffice. But you may want to copy only a subset of the data and perhaps enter an offset value, for example.




Track Effect


[image: _images/kdenlive2304_effects-track_effect.webp]

Track effect indicators



Effects can be added to an entire track affecting all clips in that track. Simply drag an effect from the Effects Tab to the header of the desired track, or click on the [image: tools-wizard]Track Effect icon and drag the effect to the track’s effect stack.



Hlavní efekt

If you want to apply audio or video effects throughout the whole video. Click on the Master button above the track headers to see the Master Effect Stack where you can add effects just like with clips or tracks.


[image: _images/master.gif]

Adding a Sepia effect to the entire video



There are specific effects and filters that work Na Hlavním only.



Effect Zones

Effect Zones allow you to apply effects to specific regions of tracks or the timeline. Zones can be set from the effect zone bar in the Timeline or from the interface in the effect panel.


[image: _images/Track-effect-zone.gif]

Track Effect Zone




[image: _images/Timeline-effect-zone.gif]

Master Effect Zone





Masking Effects

This feature allows to apply effects only to specific regions of a clip by using masks. In its current implementation the process requires three steps:


	Add one of the three available masks: Shape alpha (mask), Rotoscoping (mask) or Alpha shapes (mask).


	Add an effect (or effects) to be applied to the masked region


	Add the Mask Apply effect to activate the mask to the effects in step 2





[image: _images/mask.gif]

Using Rotoscoping (mask) to apply the Saturation effect in one specific region only

You can apply more than one mask per clip by following the same three-step process.



Video Effects

The video effects are divided into the following categories:



	Alpha, Mask and Keying

	Rozostření a zaostření

	Barva a korekce obrázku

	Vlastní efekty

	Vygenerovat

	Zrno a šum

	Image Adjustments

	Misc Effects

	Pohyb

	Na Hlavním

	Stylovat

	Transform, Distort and Perspective

	Utility

	VR360 and 3D

	Deprecated Effects





The available effects are defined by .xml files found in .local/share/kdenlive/effects (e.g. /usr/share/kdenlive/effects).

These .xml files contain the default values for the effects parameters. So if you don’t like the default values for the effects in Kdenlive, you can modify the defaults by editing these .xml files.

See also here for an alphabetical list of effects and filters.



Afekty audia

The audio effects are divided into the following categories:



	Audio

	Kanály

	Moduly CMT

	EQ and Filters

	Moduly LADSPA

	Modulators

	Pitch and Time

	Reverb, Echo and Delays

	Moduly SWH Steva Harrise

	Stereo and Binaural Images

	Moduly TAP

	Nástroje

	Volume and Dynamics





The available effects are defined by .xml files found in .local/share/kdenlive/effects (e.g. /usr/share/kdenlive/effects).

These .xml files contain the default values for the effects parameters. So if you don’t like the default values for the effects in Kdenlive, you can modify the defaults by editing these .xml files.

See also here for an alphabetical list of effects and filters.



Alphabetical List of all Effects and Filters



	Abecední seznam efektů a filtrů







Zvukové nástroje



	Zvukové nástroje







Time Remapping

The Time Remap feature allows to keyframe the speed of a clip to achieve effects like speed ramping.


[image: _images/timeremap.gif]

Example of using Time remapping for speed ramping



See also this tutorial.



Speech-to-Text



	Mluvené slovo na text







Titulky



	Titulky







Effects Demos

The following three YouTube videos display the results of a number of the video effects available in Kdenlive (Spanish captioning).


	https://youtu.be/C6oeu2Yc64I


	https://youtu.be/jrC4F_G64jAg


	https://youtu.be/XMoSgHHbA4k




Another YouTube video (English Captions).


	https://youtu.be/capV7lUzbOw




See also this YouTube play list from Franz M.P.





[1]
(1,2)
If you do not see a keyframe panel check whether the keyframe panel has been switched off for this effect ([image: keyframe-disable] icon in the effect toolbar) or perhaps the effect is simply not keyframable.



[2]
Robert Penners equations: http://robertpenner.com/easing/



[3]
MMB = Middle Mouse Button (mouse wheel pressed), RMB = Right Mouse Button







            

          

      

      

    

  

    
      
          
            
  
Transitions and Compositions

Compositing is the process of combining several visual elements from different sources into a single video. It involves replacing selected parts of an image or video with other material, usually other images or videos.

To create a composite from several clips, you make parts of one or more of the clips transparent so that the other clips can show through. Alpha shapes, rotoscoping, and masks are the most common features for making portions of the clips transparent.

You can use the Opacity parameter in the Transform effect to control uniform transparency of a clip. This can be animated using keyframes to fade a clip down or up over time.

Some clips may have their transparency information stored in the alpha channel. You can tell Kdenlive how to use this information during compositing. The following file formats may contain an alpha channel:


	Formáty souboru obrázku:

	EXR, PNG, APNG, TIFF, GIF, SVG, JXL



	Formátu souboru video:

	MOV, HEVC, WEBM





Compositing more than two clips requires subsequent compositions between the other tracks, or the clever use of alpha channels and mattes.

In Kdenlive, you put the different sources into tracks in the Timeline and use Compositions to tell Kdenlive how to combine them. For example, the Dissolve composition fades out one clip while fading in another over a certain number of frames.

That is why Kompozice are often referred to as Přechody.


Poznámka

Alpha channels are taken into account automatically so that clips with alpha can be stacked on top of each other without the need of compositions.









            

          

      

      

    

  

    
      
          
            
  
Probíhá export

Exporting in Kdenlive means Rendering, or vice versa. Rendering turns the project’s timeline with all the edited clips into the final product: a single complete video file.

Kdenlive uses Presets or Rendering Profiles to control or determine the output. You can create your own presets and profiles.

Hit Ctrl+Return to open the rendering dialog or use the Menu ‣ File ‣ Render and click on the render button [image: media-record].


[image: _images/kdenlive2212_rendering-render_dialog.webp]

Rendering dialog window




	Select the Output file location


	Select the desired Presets. MP4-H264/AAC works nearly everywhere.


	Click on Render to File button.




Once the video is rendered you can double-click the blue banner with the file name to start playback.


[image: _images/kdenlive2402_rendering-window.webp]

Window after rendering is complete



Or right-click on the file name to either Add to current  project or Open contained folder where the video is saved.







            

          

      

      

    

  

    
      
          
            
  
Řešení problémů

This section tries to help fixing issues you may encounter when installing or using Kdenlive. If your specific problem cannot be solved here try to reach out to the Kdenlive community on Discuss, Telegram, r/kdenlive[1] or Discord[1].

Please do not hesitate to log a bug report if you cannot get a problem resolved.





[1]
(1,2)
This site/channel is privately maintained and not an official Kdenlive site or channel









            

          

      

      

    

  

    
      
          
            
  
Glosář


	Aktiva
	An asset is any multimedia file (video, audio, image), title clip, color clip, and animation that can be and is used in a project. All assets are listed in the Project Bin.



	Aktivní stopa
	Can accept clips. Indicated by a highlighted track number.



	Audio stopa
	A track in the timeline that holds either the audio stream of a video clip or an audio file itself



	Barevné prostředí
	A color space is a specific organization of colors. It is a useful conceptual tool for understanding the color capabilities of a particular device or digital file. When trying to reproduce color on another device, color spaces can show whether shadow/highlight detail and color saturation can be retained, and by how much either will be compromised. See this article about color space in Wikipedia.



	Barva a korekce obrázku
	A category of effects and filters to adjust or change the color components of the clip.



	Bin
	See Project Bin



	Chroma
	Barevnost
	The signal used in video systems to convey the color information of the picture. Chrominance is usually represented as two-color difference components: U (blue projection) = B‘ - Y‘ (blue - luma) and V (red projection) = R‘ - Y‘ (red - luma). See also YUV.



	CMYK
	A subtractive color model based on the CMY color model used in printing. The abbreviation refers to the four ink plates used: cyan, magenta, yellow and key (black).



	Color Grading
	The process of creating consistent color tones throughout the film in order to give it a specific aesthetic look and style.



	Časová osa
	The central part of Kdenlive. This is where all the editing takes place. Keeps a chronological sequence of the clips and the relations to each other through tracks and compositions. Can be zoomed. See also Posloupnost for nested timelines.



	Dynamický text
	An effect that can be applied to a clip, track or on master to overlay the video with specific information. Available keyword are: timecode, frame, filedate, localfiledate, source frame rate, source codec, source bit rate, source width, source height, source comment



	Efekt
	Also referred to as a filter, an effect is used to change the appearance, size or position of a clip. Most effects have keyframe capabilities. More than one effect can be used on the same clip (stacking). In that case effects are processed top down, so sequence is important. See Effect/Composition Stack.



	Filtr
	Kdenlive uses filters from avfilter and frei0r to modify frames. See effect.



	FPS
	Snímků za sekundu
	Vzorkovací frekvence
	The frame rate expressed in frames per second or FPS is typically the frequency (rate) at which consecutive images (frames) are captured or displayed. A good frame-rate primer including a list of typical frame rates for different types of video can be found on techsmith.com.



	Gama
	Gama korekce
	A description of the relationship between a color value and its brightness on a particular device. Hence Gamma Correction is the nonlinear operation for encoding and decoding luminance in video or digital images to adjust color tones to how humans see them.



	Hamburgerová nabídka
	Sendvičová nabídka
	A way to reduce clutter and save screen real estate. Looks like this [image: nabídka aplikací]. Replaces the Kdenlive menu bar. Can be expanded with Ctrl+M.



	Havárie
	The instance when you realize you have not saved your project for at least two hours and worked on the most difficult edits. See backup.



	Histogram
	Displays a frequency histogram of the luminance of the color components of the video. See Nabídka Pohled, and in particular How the Histogram Works for a more detailed under-the-hood view.



	Hlavní Audio
	The volume of all of the audio tracks when merged into one during rendering. See Zvukové nástroje.



	Ikona
	A graphical representation of an action, function, option or status.



	In-point
	An In-point defines the beginning of a zone. A zone can be defined in the timeline and the project monitor (it has the same result), or in the clip monitor (useful to move only a certain section of a clip to the timeline). See zone for possible usages.



	Jas
	Also called brightness, lightness is the amount of white or black mixed in with the color. Lightness is more a subjective measure of perceived light, while brightness is an absolute measure of emitted or reflected light from an object. Compare tint and shade.



	Jog Shuttle
	An external device that improves video editing by using a rotary knob to scrub through the timeline, and providing a special keyboard for actions like cutting, inserting, deleting, slip and ripple editing, etc. It can be used with Kdenlive and configured in Menu ‣ Settings ‣ Configure Kdenlive ‣ JogShuttle. See Settings.



	Kelvin
	Kelvin is the base unit of temperature in the International System of Units (SI). It is also used as a measure of the color temperature of light sources. True story: A physicist cooled himself to -273.15C. He was 0K.



	Klip
	Essentially any file with video and/or audio, a simple image or any asset created through Kdenlive, e.g. title clip, color clip, animation (via Glaxnimate). A clip can be in the Project Bin or Timeline, or be referred to as the result of a Render. See chapter Add Clip or Folder



	Klíčový snímek
	Defines the frame in a clip where something starts or changes. Most effects have keyframes to allow changes over time. For example, the X and Y coordinates of the Transform effect can be keyframed to move a clip across the screen. See Working with Keyframes in the Effect Stack.



	Knihovna
	Holds assets for generic use in projects. For example, watermarks, logos, lower-thirds, intros, and so on. See the chapter Library.



	Kodek
	Short for coder/decoder. Is a hardware- or software-based process that compresses or decompresses large amount of data. Examples are MPEG, H.264, VP8/VP9, Apple ProRes. Not to be confused with container.



	Kompozice
	Also referred to as a transition, it combines at least two input clips to one output clip. Compositions cannot be stacked. See chapters Kompozice and Přechody.



	Koncový bod
	An Out-point defines the end of a zone. A zone can be defined in the timeline and the project monitor (it has the same result), or in the clip monitor (useful to move only a certain section of a clip to the timeline). See zone for possible usages.



	Kontejner
	Formát kontejneru
	A type of file that encapsulates multiple (compressed) data streams in one file (wrapper), usually together with metadata for identifying or further detailing the embedded streams. Examples are Matroska (.mkv), OGG (.ogg), MPEG-4 (.mp4), AVI.



	Krytí
	A measure of impenetrability to electromagnetic or other kinds of radiation, especially visible light. An object that does not allow any visible light to go through is fully opaque or has 100% opacity.



	Kurzor
	See Playhead



	Luma
	Svítivost
	Represents the brightness of an image or video. Luma is typically paired with chrominance. Luma represents the achromatic (aka black-and-white) image, while the chroma components represent the color information.



	Maska
	An area to block out parts of an image. Can be used to apply an effect only to the masked area (see Mask Apply) or to have an underlying clip show through (see Rotoskopie, Tvary v alfa kanálu, Tvar alfa and Rectangular Alpha Mask).



	Master
	Hlavní efekt
	A special effect stack that applies to all clips in all of the tracks.



	Matice barev
	Describes the balancing of different parts of the color spectrum in order to create an accurate representation for capture. By adjusting the properties of color matrix you can do things like shifting the white balance, alter the color palette, adjusting for color anomalies in the source.



	MELT
	melt
	Melt was developed as a test tool for the MLT framework. If you will, Kdenlive is a front-end for melt writing .mlt XML files that code the edit points and transitions. It then calls melt to render the video. See Často kladené dotazy.



	Monitor
	A device to display a video signal. Kdenlive uses a Clip Monitor to play clips selected in the project bin and Project Monitor to play clips in the timeline. Monitor is widget that can be switched on and off via Menu ‣ View. See Monitory.



	Monitor klipu
	The Clip Monitor plays the clip currently selected in the Project Bin. See Monitory and overlay.



	Monitor projektu
	The Project Monitor plays clips selected in the timeline or simply the project.



	MOVIT
	A library for high-quality, high-performance video filters. Is needed to enable GPU-supported preview and playback. See Configure Playback in Menu ‣ Settings ‣ Configure Kdenlive.



	Nastavení projektu
	Defines the format (dimensions, aspect ratio, frames-per-second setting) of the project through the choice of profile or preset, which working directory to use, how many video and audio tracks there are initially, and which profile to use for previews. Stores metadata for your project (e.g. title, author, copyright information). See chapter Project Settings.



	Nasycení
	Color saturation is a degree of intensity of a color in an image or video. As saturation increases, the color appears to be more pure. Compare hue and tint.



	Náhled
	A small image representation of a much larger image. Used in the timeline at the start and end of a clip. See Zobrazovat video miniatury.



	Nástrojový tip
	A small window with more information about a function that pops up when hovering the mouse over an icon or button. Press Shift to get even more details (not available for all functions).



	Neaktivní stopa
	Cannot accept clips. Indicated by a greyed out track number.



	Nested Timeline
	See Sequence



	Obchod KDE
	An online app store where users can upload files like lumas for wipes, presets for rendering, title templates, library clips and even project files. See Karta efektů icon #7.



	Oprava barev
	The process of correcting color issues and making footage appear as natural as possible. The idea is to make the images look like the human eyes would see them in the real world.



	Pásmo
	A defined region of a clip or the timeline. Use a clip zone to bring only a portion of the clip into the timeline. Use a timeline zone to render only that portion (see Selected Zone). Define a zone for preview rendering (see Timeline Preview Rendering). A zone is defined by setting an in-point and an out-point.



	Playhead
	The upside-down triangle in the timeline ruler. Indicates the (play) position in the timeline. During 3-point Editing determines where a clip or clip zone will be added to the timeline. Drag it across to scrub the timeline.



	Pořadí půlsnímků
	Also called Field Dominance. Determines in a video stream which field of an interlaced video stream comes first. See this article about Field Order.



	Posloupnost
	Introduced with version 23.04.0, a sequence is basically a timeline. Sequences are part of a project but can be rendered independently. A project can have multiple sequences (hence the alias ‚nested timelines‘). See Posloupnost.



	Posterize
	Posterization
	Is the conversion of a continuous gradation of tone or color to several regions of fewer tones or color, causing abrupt changes from one tone or color to the other. The term comes from the process of creating posters. The effect is most visible when a JPEG image with millions of colors is converted to the GIF format with only 256 colors.



	Pravidlo časové osy
	Sits right above the tracks and displays the time code information (default notation is hh:mm:ss:ff, can be switched to frames) as well as any currently defined timeline zone and/or preview render zone. See Pravidlo časové osy.



	Probíhá export
	See Rendering



	Profil
	For rendering see preset, for project see project settings



	Progresivní
	A format of displaying, storing or transmitting video in which all the lines of each frame are drawn in sequence. The ‚p‘ in 1080p indicates that the format is using progressive scan, i.e. the frame’s lines are not interlaced.



	Prohlížeč médií
	Allows easy browsing of the file system and previewing media clips and other assets for importing to the Project Bin. A widget that can be switched on and off via Menu ‣ View ‣ Media Browser. See the chapter media_browser.



	Projekt
	The sum of all assets, clips, tracks, effects, transitions, compositions and settings, their arrangements in the timeline, and references to all the source materials including their proxy work copies. The project file is associated with a working directory where Kdenlive generates proxies and thumbs.



	Prokládané
	Prokládat
	A technique for doubling the perceived frame rate of a video without using extra bandwidth. Compare progressive. See this Wikipedia article about Interlaced Video.



	Proud
	A part of an (encoded) media file containing either video or audio data. Use a tool like ffprobe to examine media files.



	Proxy
	A light-weight version of the original clip. Used to make editing and in particular playback easier and smoother. See Zástupný klip.



	Přechod
	A Wipe or Dissolve composition between two overlapping clips. See chapters Kompozice and Přechody.



	Přednastavení
	Used for rendering to determine output format (container), codec, dimensions, aspect ratio, bit rate and various other parameters. See Render Profile Parameters Explained.



	Překódovat
	Converts a video or audio clip from one format to another. Is needed (and automatically proposed when loaded in to the project bin) for files that are not in an editing-friendly format. See Překódovat.



	Přepínací tlačítko
	Used to select one option and one option only from a list of option. Like in the old days on a radio to select a pre-programmed station: press the stations‘ button and the previously pressed button pops out.



	Přesah
	Clip and Project Monitor can have an overlay that helps with editing. Hover the mouse over the hot zone of the respective monitor (default is the top right-hand corner) and click on the grid icon to cycle through the available patterns. Different from Dynamic Text and video overlay.



	Quality, custom
	A setting in the rendering dialog More Options section to control the quality of the rendered video.



	Rendering Profile
	See Preset



	Renderování
	Also referred to as ‚Exporting‘. The process of saving the edited clips into a single complete video clip. See Renderování.



	RGB přehlídka
	An RGB parade is a video editing tool (a “scope”) that separates the red, green, and blue color channels of an image in order to analyze their levels and distribution; it is essential for color correction to detect color casts, adjust white balance (ideally, all channels should match), and ensure that no details are clipped in highlights or shadows by graphically displaying the brightness values of each color.



	Ripple Tool
	Used in editing. Changes the original duration of the clip. Compare with working with old film material: The film strip is lengthened or shortened and in so doing the adjacent clips are moved back and forth. See Timeline Edit Tools.



	Rovina
	Used on color correction and blur application to separate color components for the purpose of applying an effect only to that component. Color components are RGB (Red, Green, Blue) and YUV (luminance (Y), blue projection (U), red projection (V)) , as well as alpha (channel).



	Rozsah barev
	A term with more significance in broadcasting. Today’s video recording equipment records in full range. Each color component is 8-bit and can have a value from 0 to 255, but only when in full range. Otherwise, for allowing headroom for video processing and exposure ranges, ranges are smaller, like 16-235 for luma, and 16-240 for chroma.



	Rozvržení
	A particular way widgets are arranged on the screen to support different workflows or tasks. Kdenlive can save different layouts for logging, editing, audio and color. See Rozvržení pracovní plochy.



	Same-track transition
	Also known as mixes. A transition between clips on the same track. See Mixes / Same-track Transitions.



	Sbalit
	In color theory, a shade is a mixture of a color with black, increasing its darkness. Compare tint, hue and saturation.



	Setření
	A special type of composition mostly used as a transition from one clip to another. See Wipe.



	Slip Tool
	Used in editing. Keeps the original duration of the clip. Compare with working with old film material: the film strip is slipped back and forth beneath the given „window“ of the clip length. See Timeline Edit Tools



	Směšovače
	See Same-track Transition



	Snap Point
	Sections in clips that other clips snap to when „snapping“ is turned on. Snap points include markers, timeline markers, zone in-points, zone out-points, transition start points, clip edges, and cuts.



	Speed Ramping
	See Time Remapping



	Stopa
	Holds various assets in the timeline. Can be muted and locked individually. Can have effects in its own stack that apply to all clips in that track. Track height can be adjusted. Tracks can be inserted and deleted. Video tracks only accept clips with video, image, title, or color; audio tracks only accept pure audio clips or the audio track of a video clip. There is a relationship between video and audio tracks: A video clip with an audio stream can only be put into a track where there is a corresponding audio track - V1/A1, V2/A2, V3/A3 and so on. See Stopy.



	Teplota
	Teplota barvy
	A parameter describing the color of the visible light source. It is measured in Kelvins (K). The range is from 1,000K to 10,000K where lower temperatures are considered „warm“, and higher temperatures „cool“. See this article about color temperature.

Theme
A set of colors, icons, fonts and other settings to change the appearance of an application or desktop. Can be set from Menu ‣ Settings ‣ Color Scheme.



	Time Remapping
	A special widget allowing to keyframe the speed of a clip to achieve effects like speed ramping. See Time Remapping.



	Timeline Marker (former Guide)
	Static markings in the timeline that do not necessarily move with clips. Not to be confused with markers. Can be used to define regions for rendering and exported to provide chapters for YouTube videos. See Timeline Markers.



	Timeline Zone
	See Zone



	Titulkový pruh
	Part of a widget’s window displaying additional information (e.g. name, title, action icons). You can grab a widget by the title bar and move it around. See Přesunování widgetů.



	Tón
	Means a degree of lightness, darkness or strength of a color. Compare saturation, tint and shade.



	Tónování
	In color theory a tint is a mixture of a color with white, increasing the lightness. Compare shade, hue and saturation.



	Upravit režim
	A special function of the project monitor. Needed in order to be able to use the mouse to manipulate certain aspects (e.g. size, position) of some effects (e.g. Transform, Rotoscope). Can be switched on and off using the [image: edit-mode] icon in the project monitor’s toolbar.



	Uzamknout
	Locks a track for editing. Indicated by a closed padlock icon.



	Video
	An asset or file with a video stream.



	Video Overlay
	Additional information (e.g. timecode) that is overlayed during the render process. Can be selected in the More Options section of the Render Dialog.



	Video stopa
	A type of track that only accepts clips with video, image, title, or color. Needs a corresponding audio track to accept a clip with video and audio stream. See Stopy.



	Výuka
	A step-by-step instruction to use a function, tool, effect or combination of these to achieve a certain result. Often created as a video with commentary or just explanatory text. There are many tutorials for Kdenlive available via a simple Google or YouTube search.



	Widget
	A blend (portmanteau) of ‚window‘ and ‚gadget‘ coined by American playwright George S. Kaufman in 1924. A small applet as part of the layout for a specific tool or panel that can be moved around the screen and docked in specific places in order to accommodate different workflows. See Uživatelské rozhraní.



	YCbCr
	A color space used for any digital encoding of YCbCr suited for video and image compression and transmission formats such as MPEG and JPEG. For more details refer to the Wikipedia page about YCbCr.



	YIQ
	Color space used by the analog NTSC color TV system. For more details see the Wikipedia page about YIQ.



	YPbPr
	A color space used in video electronics. Also written as Y’PbPr or YPBPR. Used in particular when referring to component video cables. For more details see the Wikipedia page about YPbPr.



	YUV
	A color model used to encode a color image or video taking human perception into account. Y stands for the luminance, U for blue projection and V for red projection.



	Zastaralé
	Obsolete, not used anymore. Effects in the Deprecated category are still available but are not maintained and can lead to unwanted results.



	Záloha
	Kdenlive creates backup files for the current project. They are stored in a special folder. See the chapter Backup.



	Záložky
	Belong to the clip they have been created in/for and move with it. Changes to a marker apply to all copies of the clip in the timeline. See Značky.



	Zásobník
	The list of effects applied to a clip, track or master. An effect stack is processed top down, so sequence is important. See Effect/Composition Stack.



	Zásobník projektu
	Lists all the clips and assets that are associated with the project. Referred to as the ‚Project Tree‘ in earlier versions. See the chapter Project Bin.



	Ztlumit
	Temporarily disable a video or audio track.



	Zvětšení
	Increase or decrease the level of detail. You can zoom the timeline by using the icons or by Ctrl+wheel. Clip and Project Monitor can be zoomed by clicking on the icons in the monitor overlay or with Ctrl+wheel.



	Zvukový směšovač
	A widget that displays VU meters and has sliders to control the volume of the respective audio tracks. See Zvukové nástroje.








            

          

      

      

    

  _images/Kdenlive_menubar_off.png
sae | o Coreto [ copr B pose

v - T

cip >
Timeline >

Monitor >
Settings >

Help >






_images/Kdenlive_menubar_warning.png
. “This will hide the menu bar completely. You can show it again by typing Ctri+M.

Do not show this message again

NS





_images/Kdenlive_import_keyframes_dialog.png
Datatoimport: rect  ~

© X(28-1330) © Y(3626)  Width(727-1920) W Height (4!

n o 00:00:00:00 =

out ) 00:00:17:08 &

Map Geomet ~ to Rectangle ~ Ao

[

o 00:00:45:20

Source range:

(-28-1920), (3-1080)

Destination range 0

Actual range only

it keyframe number 20 3|

[ Ognel






_images/Kdenlive_menubar.png
File Edit View Project Tool Clip Timeline Monitor Settings Help Loggng Ediing  Audio  Effects Color





_images/Kdenlive_reorder_sequence_tabs.webp


_images/Kdenlive_statusbar.png
‘Shift drag for rubber-band selection, Shift click for multiple selection, Meta drag to move a grouped lip to another track, Ctrl drag to pan select |[® B[ w[F[t=| @ @






_images/Kdenlive_extra_toolbar.png
© Render..  Ctrl+Return
@ Stop Render






_images/Kdenlive_guides_view_markers.png
Guides

Markers for Billard.avi

1 00:00:01:02 Marker1
00:00:03:06 Marker2
00:00:05:13 Marker3

b Add Markers - Kdenlive

Position

Comment | [iEEREH

category [l Gategory 1

‘Add mutiple markers

Count | 2

© Abbrechen





_images/Kdenlive_add_guide_double-click.png





_images/Kdenlive_export_guides_22-12.png
Marker Type: | Al Categories v

Save As: (®) Text File Kdenlive JSON

Text Options
Offset: | Disabled V| 00:00:00:00 °
Format: | ({timecode}} {{comment}} (0]

Exported: Category name - {{category}}

quder | Guide comment - {{comment}}

quide2 B
Shides | Guide position in frames - {frame}}

quided | Guide number - {{index}}
Next guide position in (HH)MM.SS - {(nexttimecode}}
Guide position in HHMMSSFF - ({realtimecode}}
Guide position in (HHIMM.SS - {{timecode]}

T you are using the exported text for YouTube, you might want to check: )
1. The start time of 00:00 must have a chapter.

2. There must be at least three timestamps in ascending order.

3. The minimurm length for video chapters is 10 seconds.

[ Copy to Clipboard

@ Close





_images/KdenliveProjectEdit.jpg
SIS SEE R o Ui Monchs S eI s e
R o Bse @uce oo Moo fgrse ® peer
e Tree o x| sk o x
R O Effects for 00045 MTS

Project Monitor o x

dip v Description

Centerwav
1 min. 02 sec. (1)

LFEway
1 min. 02 sec. (1)
Surroundavay

1 min. 02 sec. (1)

Frontavay
1 min. 02 sec. (1)

B O «“hrbvm %ot 000254 &

Clip Monitor || project Monitor
00000000 00003000 00010000

Project Tree || Project Notes. Effect st || Effectstack || Transition

00013000
Video 1

oGz
Video2

80z
Video

o0
Audio 1

o6

Audio2

o0

Audio 3

o6

Audio 4

(=R

B Nve 8@ -] OOED wotows/mores





_images/Kdenlive_Affine_rotate_kf2.png
Tansition ®

Tpe [Affine 2] witntrack (M video3 @) 2|
. * *
@-0x :
x 0y 0 W 720 H 576

[l T3

Size|  100.00% | Opacity 100%
Rotate X 0 | [Rotate Y 1800 | Rotate Z 0
Distort

Fx shear v [
Fix Shear X 0

Fix Shear Z 0





_images/Kdenlive-restore-audio.gif
I —

F_W.X Ty —

00000824 Q0001307 Q00017118 01






_images/Kdenlive-timeline-righ-click-markersmenu.png
o R R s
-+ BtctClp | m——
Save Timeline Zone to B R AR

R © v

[ Add Marker/Guide quickly *

Align Audio to Reference. & Edit Marker
@ Change Speed 77 Delete Marker
@ Clipin Project Bin 7 Delete All Markers

% CutCiip Shift+R





_images/Kdenlive_Blur.png
TP






_images/Kdenlive_Captured_files_dialog.png
Captured files.

File name. a size

- - [
n

Close. import





_images/Kdenlive_Affine_rotate_timeline.png
Project Tree | Project Notes Effect List | Effect Stack

00:00:10:00

T & 00:00:0000
Video1 |
com
Video2 |

com
Py






_images/Kdenlive_Affine_transition.png
Tanstion ®
Type |Affine é ‘
’ * ’
®-® .~ :
x 0y 0 W 720 H 576
[l T3
Size|  100.00% | Opacity 100%
Rotate X 928 | Rotate Y 0 | [Rotate Z o
Distort
Fix Shear Y. o
Fix Shear X o
Fix Shear Z o





_images/Kdenlive_Config_wizard.png
Welcome
This is the first time you run Kdenlive. This wizard will

let you adjust some basic settings, you will be ready to
edit your first movie in a few seconds...

Next> || Cancel

b

—

T R





_images/Kdenlive_Configure_Capture.png
®
Capture @

Default capture device |Firewire 5

Firewire | FFmpeg | Screen Grab | Blackmagic

dugrab version 3.5 at /usr/bin/dvgrab

Capture format  [DV.Raw.

() Automatically start a new file on scene cut

() Add recording time to captured file name

Capture file name |capture

dugrab additional parameters.
Capture ‘

O
Jogshuttle

®

Playback

[)

Transcode

Brelp || 5 Defaults v apoly | | @cancel | ([ISPOKIN






_images/Kdenlive_DVD_wizard1.png
A
DVD Wizard

Select Files For Your DVD

DVD format |PAL43.

() Intro movie

File Duration

t /home/ttguy/Videos/wipe_demo.vob  00:00:26

[ Add movie file | % N

9.8 MiB






_images/Kdenlive_DVD_wizard2.png
DVD Wizard

| DVD Chapters

v

@0 -0 @ 00:00:0000 |-

Movie file |/home/ttguy/Videos/wipe_demo.vob. ™

00:00:00

(

Add chapter | | Remove chapter
Hitoad | [ Hsave <Back Next> cancel





_images/Kdenlive_Configure_shortcuts_1.png
- General
% About KDE
% About Kdenive
- Add CGip

1 Add Cip or Folder...
I Add Color Cip...
E Add Image Sequence...
T, Add Tempite Tite...
T: Add Titke Clp.

» Add Cip to Selection

e
——— [P ——

[ vefauts| | premiere —— [« ok | [Manoge Schemes << | & erint... || © cancel |

Import Scheme...
Download New Keyboard Schemes...






_images/Kdenlive_Connect_firewire_button.png





_images/Kdenlive_DVD_wizard5.png
DVD Wizard

®
Creating DVD Image
Temporary data folder |/tmp/ CN=]
DVD IS0 image [/home/ttguy/demo_dvd_kdenlive.iso CN=]

& Creating menu images

& Creating menu background
& Creating menu movie

& Creating dvd structure

| Creatinaiso file

Create ISO image Abort
staus (@suny

: The File(s) Block(s) 5171
UDF Anchor end volume start Block 5449
Done with: UDF Anchor end volume Block(s) 1
Writing: UDF Pad end start Block 5450
Done with: UDF Pad end Block(s) 150
Max brk space used 15000
5600 extents written (10 MB) ¥






_images/Kdenlive_Disconnect_capture.png





_images/Kdenlive_DVD_wizard3.png
DVD Wizard

Create DVD Menu

& Create basic menu

Button | Background

Text |Chapter 2 | Target |00:00:11
Font 35 | ||ubuntu [+]
Button colors |
o
@
&

HiLoad kel save <Back Next> cancel






_images/Kdenlive_DVD_wizard4.png
DVD Wizard

®
Creating DVD Image
Temporary data folder [/tmp/ CN=]
DVD ISO image /home/ttguy/demo_dvd_kdenlive.iso CN=]
Creating menu images

Creating menu background
Creating menu movie
Creating dvd structure
Creating o file

Create ISO image. Abort

o |






_images/Kdenlive_Grouped_video_audio.png





_images/Kdenlive_Configure_notifications.png
Configure Notifications - Kdenlive

state Title Description

Frame captured A frame was captured to disk
Rendering finished Rendering is over

Error An error occurred in Kdenlive
dy to captut
Rendering started Rendering was started

& ® Playasound [® [kDE-sys-App-Positive.ogg a8
[ @ Show a message ina popup

) [ Logtoafile

[ P Mark taskbar entry

) © Run command

oot [woa





_images/Kdenlive_Insert_mode1before.png
poc03000 00:00:40:00 00:00:50:00 ostioose 0001:10:00 0001:20:00
| | | |






_images/Kdenlive_Installed_render_profiles.png
Rendering

Render Project ‘ Job Queue | Scripts

Destination @ web sites

Output file tguy/Videos/wipe_demo.mpa < [
(@] (7 show all profiles [=2]]

€ YouTube 1280x720 3000k






_images/Kdenlive_Markers_and_guides_crop.png





_images/Kdenlive_Motion_speed_effect.png
v A Speed =R
Speed 100%

‘Stroboscope 5






_images/Kdenlive_Main_tool_bar.png
[ New  [3 open 5] Paste





_images/Kdenlive_Manage_project_profiles.png
Profies o]
Pt WE
Properties
Description DV/DVD Widescreen PAL
size 720 . x|576 =
Frame rate 25 HVAL N
Fields per second 50.00
Pixel aspect ratio |64 HYars N
Display aspect ratio |16 ByaB N
Colorspace [rmu-R 601 |
[ Progressive

L vessss | (e






_images/Kdenlive_Insert_mode0before.png
18 / 00:01:58:08  wip wie wik w

* (© v

poc03000 00:00:40:00 00:00:50:00 ostioose 0001:10:00 0001:20:00
| | | |

Little Pi






_images/Kdenlive_Insert_mode1after.png
e =R e ®

-

poc03000 00:00:40:00 0000:50:00 ostioose 0001:10:00 0001:20:00
| | | |






_images/Kdenlive_Settings_OSX.png
i Download New Wipes...
# Download New Render Profiles.
i Download New Project Profiles.

i Download New Title Templates...

% Run Config Wizard
Themes

Toolbars Shown
 Show Statusbar

&2 Full Screen Mode

% Configure Shortcuts.
# Configure Toolbars
O Configure Notification:






_images/Kdenlive_Shift_click_drag_to_multi_select.png
et st Project Monitor | Lfip Monit

200 |

00:02:00:00 00:02,30:00

D iptureDO0:.
i





_images/Kdenlive_Render_dialog_vbr_0.9.10.png
Render Project | Job Queue | Scripts

Destination & File rendering .
output file /home/ttguy/Videos/mov/LPs/LPsovbr_Q20.mp4 @ (B3]
@ [ show all profiles &) (2

MP4 . H.264/AAC High Profile

MPEG-2 [ H.264/AAC (CBR)

Matroska MPEG-4/MP3 Advanced Simple Profile
HDV - MPEG-4/MP3 (CBR)

Scanning Auto z File size
g Vvideo 14 g,

Encoder threads |1 iy
@ Export audio (automatic) Audo 150 a

- . . bitrate

(7] Render using proxy clips
[ Rescale 512 x (409 (@
(] Play after render
(7] Export metadata (] overlay

O Fullproject @ Selected zone

Render toFile | | Generate Script Close





_images/Kdenlive_Render_export_audio_auto_vs_just_checked2.png
Rendering

Render Project | Job Queue | Scripts

/nome/nguymdeos/dag_mnud_exp_audlo_am.m.u

v endering finished in 00:00:16
e 1
/home/tlglly/VIdens[dag_rﬂhud_exp_illdIo.mpd
¥ Rendering finished in 00:00:18 2
/home/ttguy/Videos/dog_rotated_exp_audio_auto_with_audio.mps 5
¥ Rendering finished in 00:00:21
o Thome/ttguy/Videos/dog_rotated_exp_audio_unchecked_with_audio.mpa

Rendering finished in 00:00:21
‘without audio trad






_images/Kdenlive_Video_with_no_audio.png
Project Tree | Project Notes

00:00:00,00
-






_images/Kdenlive_Spacer_tool_crop.png
I & 00000000 00:01:20:00 00:02:40:00 00:04:00:00 " 00:0520:00 00:06:40:00






_images/Kdenlive_Video_plus_Audio_in_seperate_tracks.png
Project Tree | Project Notes

T & 00000000
Video 1






_images/Kdenlive_Render_dialog_0.9.8.png
Renderl

9
Render Project | Job Queue | Scripts

Destination # File rendering -
Output file /home/ttquy/Videos/gbr_snorkel1.mp4.

@) [ showall profiles &) e

MPa H.264/AAC

MPEG-2 MPEG-4/MP3

HDV

Raw DV

Scanning Auto < | Bitrate

Encoder threads | 1 I Video 2000 | v |
@ Export audio (automatic) s EES
(] 2pass (7] Render using proxy clips

[ Rescale | 512 x 240 4

(] Play after render

(] Export metadata [ ] Overlay

@ Fullproject () Selected zone

(SRR | cenerote scrpt






_images/Kdenlive_Render_dialog_cbr_0.9.10.png
Render Project | Job Queue | Scripts

Destination # File rendering -

output file /home/ttguy/Videos/mov/LPs/LPsovbr_Q20.mp4 @ (B3]
[] show all profiles & v 8

MP4. H.264/AAC High Profile

MPEG-2 ‘

Matroska | MPEG-4/MP3 Advanced Simple Profile

HDV - MPEG-4/MP3 (CBR)

properties=x264-medium vb=sbitrate+'k' pass=spasses

ab=%audiobitrate+k"

Scanning Auto z File size
Encoderthreads (1| \ideo (4000 @+
@ Export audio (automatic) :Il;g:tze e @ -
| () 2pass (] Render using proxy clips
[ Rescale 512 x | 409 @
' [ Playafter render
| [ Export metadata [ overlay

) Fullproject @ Selected zone

Render toFile | | Generate Script






_images/Kdenlive_Preferences_OSX.png
File Edit Project Tool Clip Timeline Mo

bout

project].kdenlive / DV/DVE

CY S TG

Preference:

Services > Effect Stack.

Hide xH
Hide Others  \C3¢H

B3 Quit #Q

(Fproest poc.. ) (et [oeesesmeRa] Tansiion )

<[5 co:00:00:00 00:00:30:00
T[] 2L

ey





_images/3p-Insert-clip-1.gif
File Edit View Project Tool Clip
[ New P9 open..
Project Bin

a3l el e

save | S ur

>0

Text
00:00:05:00

MVI_0952.MOV
00:00:10:06 (71

capture0029.mov.
= 00:00:12:07 11

VB 782

V@ 703






_images/3p-Source-1.gif
b R R

File Edit View Project Tool Clip 1
D New Plopen. [Eswve | 9 un

Project Bin @

MV1_0952.MOV
00:00:10:06

crash_flight_of the bumb
4

00:0119:0¢

6666.ipg
r—T— 00:00:05:00

VE 708

viEl 08





_images/23-08_delete-sequence-tab.gif
BB * = ¥ v | search..
Name ~
v P Sequences

Sequence 1

00:00:00:01

Sequence 2

00:00:0000

Sequence 3

00:00:00:00

]

Project Bin | Compositions  Effects  Clip Properties  Undo History clip

= | Znomaimode | pE[h| % oo fd 4 00:00:11:17 / 00:00:00:
Sequence 1 X Sequence2 X | Sequence 3 X
Master 00:00:

sHAQ

:00 00:00:07:






_images/3p-Advanced-edit-1.gif
v

File Edit View Project Tool Clip
[} New P open.

| Project Bin o @l

lBvE & i

save | 9 Uy

00:00:10:06 6] #81

00:0179:09

Zone 2
00:00:26:02






_images/AdvancedMixingOptions2.jpg
|

Channel: 1

e
[
[

B

Output Channels: 6






_images/Alpha-Compositing-1.jpg
A-H\u.e Irausihon

zp

opa V;"
'PI
Lo 25T
of pixel in
:“?po {r-umc‘.ls -.auoreol
IN
o o{?.xal - S °{_ ,u“.' .
l:n-lﬂ' #auue A Cowcld':aorc'
adop: o =0,





_images/3p-Target-active-1.gif
File Edt View Project Tool Clip

[ New P Open...

| Project Bin > @

sve | 9w

Text
00:00:05:00

m el |
crash flight of the bu
. 00:0119:09 i

™ e6s6.jpg
e 001000500 [1] i






_images/AdvancedMixingOptions.jpg
|

Channel: 1

0

EEE 0

Output Channels: 6






_images/Alpha-Compositing-2.jpg
Coh?o‘:h ‘-/IMJPM
»

opague
pixel
e&o{v T;(I:(cl A 5 —> o of resulhung,
VPP awe B: uupo‘&eka'y“
oves: =,
=
qu‘F pixel (u i)

—
lowses .{rawe A





_images/Alpha-Compositing-3.jpg
.l\c ’l;' : S :
_:ﬁ auy J’Oh +OPa¢ +7

uppes. pixel
?Ealo?r °‘P1:i ;$
oot Lo 2T
®p > (:auoved.)
o of )
uppes la. es r'e‘r““\u K> - r(J“H;“
ng.clh.’ 1= pixelicolor A pirel
0% . 5
Loves pixel

Color





_images/Alpha-Compositing-4.jpg
LT”‘?N;“ #-{M«'th + Opacu'-’
=p

uppes pel “
PZO'O?V OP?". ¢ll—
\00% L i B
Xo—> )
U??f{ 10\12,( 'S ..’:’ ‘:‘of “A%— ’Pkk"
0?0-6;4'7 P
0% -
LOUJ P‘-xal

Color





_images/AudacitySurround.jpg
| & &
v )| 2(Stereainput_v
215 2:30 2:45 1

Eile Edit View Transport Tracks Generate Effect Analyze Help
e

JPPPP L S

4 T el A

ALSA | 4) | cefoult

A TR |
Llolk| oy 36 20 o) 36 20

115 1:30

= + | 0.0p

L.og. R[0S

-10
1.0

S -10
X v] 1.0
Moo, 48000z
326t foat 05

AN AR ML e VLA
AR Wt L e ] B

A A 0 S A A T, _

o
B it 0000 UL A A ALl e LG il G L e

o

L0
o5
0.0 LML A OB R it Mww’m@.mw«M‘unww}u»uJAww.awwwmwugm\w‘wmuum»{-w»m»munww.wwwmuwm%wW¢mu.WwA -
G 0600 e 00 Al i G s o
05
= | |10
< <>
Project Rate (Hz): Selection Start: (_JEnd () Length  Audio Position:
[ ] |sn™ _ [00n060m00.00057 00n01m0385157 |(00n00m00.0005Y
dragtoselectaudio






_images/AudacitySurroundLFE.jpg
Eile Edit View Transport Tracks Generate Effect Analyze Help

= T | ET = -
»)m) W) w =|7] = e 0L o] & 2
w b B B o B | Alelx 120 Py 36 120 || Ay 4) et v P setait L e
P » » =

Xrea ] 10
Siereo. 8000
52t foat s
e

= R T e e

Lo

X v] 1.0
Moo, 48000
326t float 05

X v] 1.0
Stereo, 48000H
320t float 05
Mute | Solo |

05
!
0.9] f TFTETT T m
05
2 | 1o
Project Rate (Hz): Selection Start: _JEnd (s Length Audio Positio
[ v] | snapT | [00m01m000005 [00n00m0000057 |[00h00m00.000
Clickanddragtoselectaudio

Actual Rate: 48000





_images/Apply-value-to-selected-kf.gif
n\/Translorm 5™ = = A v
t t v 3oy

© @ ® & & @ Mlnear - = 00:00:06:09

X 481y 270w 956 |3 |H 537

F & 3 % b of H & &8 &

sue o720 GREY oo

Rotation
Compositing Alpha blend
Distort O

Rotate from center (]





_images/AudacityChannels2.jpg
ole| & 2 LL1R1HE L

File Edit View Transport Tracks Generate Effect

alyze Help
L[ T L W 5L

> W) ) @) l=10le— ——— /
Plolx|| 9wl 36 120 Sv| 36 120 |} ass v ) cefaute Vi v
s 10 15 20 25 30 : 40 as 50 55 1:00

Ko ~] 1o
Stereo, 480001z
32t foat o5
ute | Soia |
= I A e R e e e e

&
ik R

©;

05

[Moemer —~] 10
o, 48005H

32t ot 05
| e [ s |
G
L R
G
[X[E ~[ 1o
Hono, 8000
|2t noat 05
Wite | Sola
= | 0.0
i
L 8|05
9
] |40
[Xewoms ~] 1.0
Storeo, 48000Hz
20t oat 05
Wite | Solo|
= T n_w————u-——————m—mm—mmm
o
I R
i

Project Rate (Hz) Selection Start: End (e) Length  Audio Position
‘Actual Rate; 48000

w0 v Snap To 00h00m00.0005v 00n00m00.00057 | [00h00m00.000s

Click and dragtoselect audio





_images/Composite_transition_with_wipe_file.png
Transition ®

Tpe (Composite 2] with rack (Ao

°

@ x0 4

x [ 0w 720/ 576

R
Optionss| size| 100.00% | Opacity 97%
Alpha Channel Operation  Over =
Align
Fill

Distort

Wipe File
Wipe Softness o
Wipe Invert (m]

Force Progressive Rendering &
Force Deinterlace Overlay ~ []

Transition | Effect List | Effect Stack






_images/Configurable_thumbnails.png
vid vHS

Insert Track

Delete Track
O In Frame
@® In/out Frames
© Al Frames

# 0 & | | O NoThumbnais






_images/AudioThumbnail.png
Project Tree || Project Notes
- . 00000000
Video 1

= R
Video2

(=] =






_images/Composite_transition_showing_alpha_channel_operation_options.png
tpe Composite

2] wintrac [Auta B
IS

er o @ -
x 0 Y 0 w 720 576

[ oo o] = 2

Optionsy| Size  100.00% Opacity

Alpha Channel Operation
Align

Fill

Distort

Wipe File
Wipe Softness
Wipe Invert

Force Progressive Rendering
Force Deinterlace Overlay

Xor

None =
)

0

%

0





_images/Context-and-keybinds.gif
b LAl






_images/Contour_Design_Choose_Aplication.png
© Terget application selection

2 11> DieserPC » Lokelr Dotentrigr (C) » Programme > kdenlve > bin »

Organisieren = Neuer Ordner

® | P bindurchsuchen

Name Anderungsdstur T Grotie
i aam recuo v ji—
] Quuick 1412.2020 0446 Dsteiordner
] Qeuick2 14.12.2020 0447 Dsteiordner
[ Qffest 14.12.2020 0447 Dsteiordner
] QuWinkxtras 14.12.2020 0447 Dsteiordner
] sqldrvers 14122020 0447 Dsteiordner
[ syles 14122020 0447 Dsteiordner
[ texttospeech 14122020 0447 Dsteiordner
[ dbus-daemon.exe 300920202350 Anwendung 25k8
[ fimpeg.exe 17.11.2020 1027 Anwendung 28
[ fplay.exe 17.11.2020 1027 Anwendung 156K8
[ fprobe.exe 17.11.2020 1027 Anwendung 18
» kdenlive.exe 14122020 0447 Anwendung 8277KB|
5 kdenlive render.exe 14.12.2020 0447 Anwendung 107k
[ KioslaveS.exe 011220202055 Anwendung 538
[ meltexe 111220200539 Anwendung 538

Dateiname: | kdenlive.exe

| [Executable and Modules






_images/Contour_new_settings.png
Contour Shuttle Device Configur:

x|

ShuttlePRO v2 | Key Composer™ | About |






_images/Disabling_individual_clips.png
1G04 00:00:17:30

[ Copy
) Paste Effects
&% Group Cips

3% Ungroup Clips
%5 Edit Duration

[ Restore audio

00:00:21:06  00:00:24:32

ctr+C

crl+G
Ctri+Shift+G





_images/Duplicate-keyframe.gif
- Teansform 5o == A
i t

00:00:04:03

caoz%e 4

oo
F a2 Mbddn s
Compositing Alpha blend
Distort )

Rotate from center =





_images/Contour_open-cotrol-panel.png
C shuttePRO v2 Primary
v Global Settings

Open Control Panel

Anpassen.

| oe

» [ @ () 18:50 W





_images/Create_nested_sequence.webp


_images/Index_Editing.png
Master 00000 PO:000405  PO:000811 PO001218  PO00T6ZE  PO:0021:00  PO:002506  P0:002

vl #Ha
CEELT ]
vl 782 PE i g imps
-
I\,H 702 ‘.u.m..,‘wmw el g g

VB ¥ 0 a8 e





_images/Index_Effects.png
& Cue

Dance

B oblur

Deblock
[ Dedot

3 Deflicker

[ Deinterlace_qsv

Delay grab

Bl celayor
Delogo
Bl Dencise_vaapi






_images/Duplicate_sequence.webp


_images/Fit_all_tracks_to_view.gif
Catalogo
~ |

-

78

78

7 0
7

Tite cip
Fade out|

Tite clp
Fade out

e cip]
FadenrFa

ar Titecipl ] Titlecip! |
= B
i | |
H s!i XRecorder Screer Screenshot 2023-08-17-1 [71%] XRecorde I XRecorder_1 I| XRect XR I 167%] XR:mnI [668%] XR

[PEFE8] pressi Selecic Redimen Confir Pressior AUTORIA ANO DE CRIA LINGUAGEM || MATERIAL

[

TiTuLo






_images/Index_Rendering.png
> Rendering — Kdenlive PN

Render Project | Job Queue  Scripts

output file | /home/kde/Vvideos/file.mpd. @) | B || =mpamovfiags=+faststart vcodec=libx264
progressive=1 g=15 bf=2 crf=tquality acodec=aac.
ab=%audiobitrate+'k"

Format BB

- Generic (HD for web, mobile devices...) O ~

WebM-VP8/Vorbis (libre)

MPEG-2 2pa

Encoder speed === Encoder threads | 0

Parallel processing (experimentall)

GIF High Quality Scanning | Auto | Field






_images/Insert-mode.gif
= | Znomaimode v % h X 00 00:00:13:16 / 00:00:15:00 v

00:00:00:00 00:00:04:08 00:00:08:16 00:00:12:24
e e O e SOt
vB ¢Ba Color
Vvl sHAa @ Color Color

M-EXE





_images/Index_Logging.png
BvE o=

¥ v | seard
s o cfof ¢ =
Bue Green Cn  Red  Yellow =
Name Rating
g Broke_For_Free_- 08 - One And.mp3
00040014 Jokokk ok

astro-chicken-dance.wav.

el kA irte

GHOST - BOOM BAP HARD BEAT RAP HIP HOP INSTRUMEN1

0031520 b 0 0 ¢ i





_images/Kdenlive-addcliptotimeline.gif
File Edit View Project Tool Clip Timeline Monitor Settings Help

[ new P9 open...

w‘sm Credo [y ooy [Hpaste @ Render v

Vv sean

Procttn | Composions s CipPopertes Undoristry | CipMonter | ey

VE 208





_images/Kdenlive-change_speed_dialog.png





_images/KDENLIVE_Configure_jog_shuttle.png
Project Defaults

Timeline

e
Environment

O]

Capture

9

JogShuttle

®

Playback

)

Transcode

Brelp || 5 Defaults v apoly | | @cancel | ([ISPOKIN

Jogshuttle

[ )

[ Enable Jog Shuttle device
Device configuration

Device

Button 1 [Add clip
Button 2 |Add clip
Button 3 [Add clip
Button 4 |Add clip

Button 5 |Add clip






_images/Kdenilve_Cutting_grouped_clips.png





_images/Kdenlive-removespace.gif
vl ¢sBA *

A
w»e.

048






_images/Kdenlive-extract_clip.gif
S —
700 Bk 0l M v H >

7200
ompositons > | ClpMonitor | Lirary. Projec

mote || #% M) % o | ooo0:20:01 / cos0osaasos v | @ e -

D0:00:00 00:00:08:26 00:00:17:23 00:00:26:20 0D:00:35:16 00:00:44:13 00:00:53:
S (PR R T T

’H &

H A

) &

) &






_images/Kdenlive-middle-toolbar.png
O W Nene
O D Mixed Audiotracks | () ] Preview
© = spltAudioTacks | | @ [ HighQualy |
O = spit Audio Tracks (reverse) | |

D0 | 00:00:01:17 / 00:00:17:06 v

112 00:00:11:00 00:00:16:12 00:00:22:00 00
e i | sl Sl

B sz / 0visoniTioe v
O @ st [
O o 7 o0

@ StopPreviewRender ] &) A
£ AddPreviewZone | 1
4 Remorepreveazore. 1 Ao
= Remove AProvenzone] el
0 © Auorsicprores 14l
Disable Timeline Preview ] 4

S Manage Cached Data 149

i3






_images/Media-browser.gif
Media Browser

Places
Places

G Home

O Desktop

D pocuments

& Downloads

£ Music

EJ Pictures

H videos

W Trash

Remote

© Network
Recent

Modified Today

Modified Yesterday

Search For

Documents

Bl images

< >~ Q&

© @ | Project Bin

B=|Bve @

L v v

Search

B3 /home/farid/Videos/

a /|| Name

titles Gl Animated David Lynch's
ShortFikdenlive  Weath..webm

corte10001.mov  CGlAnimated  Water Pouring, A
Short F..MLmkv wav.mp3

capture0002wav  Honeyland.2019.  OPENING-TITULO. OPENINGTITULO_

1080p.8..XL.mp4 kdenlive

bumbum.mpa

cortel.mp4

backup0.kdenlive

bumbum-vbrmpa

capture0003.wav

capture0006flac

Name:

Filter: | All Supported Files

Import image sequence

beshare-mountain village jpg
00:00:05:00






_images/Markers_in_clip_monitor_22-12.png
Go to Marker... 00:00:01:02 Marker1
Extract Zone 00:00:03:06 Marker2
Insert Zone in Project Bin Strg+l 00:00:05:13 Marker3

Extract Frame...

Extract Frame to Project...

Add Project Note

SetZone In

Set Zone Out

Set current image as thumbnail
+ Always show audio thumbnails

Current Monitor Overlay

e e
v | Bk o« v [E] 00:00:04:

Clip Monitor | Library 100%

& Force Monitor Size > 00 3:06 Marker2
&) Background Color > | 00:00:05:13 Marker3
[ Extract Zone
[ Set current image as thumbnail
+¢ Always show audio thumbnails

Audio Scrubbing

‘Show Audio Levels

‘Show Source Timecode






_images/Multicam0.gif


_images/Move-kf-to-cursor.gif
n ~ Transform

5® == AV
i L S S SO

@ & o & & E Mlnear v 00:00:05:02 {

X ov ow 1520 |on|n 1080

F & 3 @
Sze  100,00% Opacity

Rotation

Compositing

Distort
Rotate from center

35%
Alpha blend
0

3





_images/Kdenlive_timeline_toolbar.png
= Normal Mode

e X

o0

(SAR3

00:00:12:23 / 00:00:00:00 v

[E

R

e

*

® v =

=]





_images/Kdenlive_timeline_ruler_context-menu.png
Master

200 00:00:07:04 00:00:14:09
+ Add/Remove Guide G

sBa | .

& Guides Locked

YHS B Export Guides.
o to Guide.

i SetZoneln l

08 1 Set Zone Out o

[ Add Project Note
. + Add Subitle Umschalt+S
048






_images/Kf-rubber-select.gif
00:00:00:25 &

wE o s g a4

oo
F a2 Mbkddn s
Compositing Alpha blend
Distort 0

Rotate from center






_images/Kf-ctrl-select.gif
- Teansform & ® == A
i hd t 32 St ¢ i

wa o e g a4

os
F a3 mbaddgs L3
Compositing Alpha blend

pistort 0

Rotate from center






